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Application
The FX30E and FX60E are web-based supervisory class
controllers in the Facility Explorer product family. The
FX30E/FX60E manages networks of field controllers
using open communication protocols, such as N2,
LONWORKS®, and BACnet® protocols.

Figure 1: FX30E Supervisory Controller

North American Emissions
Compliance

United States
This equipment has been tested and found to comply with the
limits for a Class A digital device pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when this equipment
is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential
area may cause harmful interference, in which case the users
will be required to correct the interference at their own
expense.

Canada
This Class (A) digital apparatus meets all the requirements of
the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la Classe (A) respecte toutes les
exigences du Règlement sur le matériel brouilleur du Canada.

Installation

Parts Included
Unpack the FX30E/FX60E and accessories (power
module, option cards), if ordered. Inspect the contents of
the packages for damaged or missing components. If
damaged, notify the appropriate carrier and return any
damaged components for repair or replacement.

Included in this package are the following items:

• FX Supervisory Series controller
• Hardware bag containing a grounding wire with quick

disconnect 0.187 in. (4.75 mm) female connector.
• Power module (if ordered). The power module may

be one of the following:
- LP-FXPM24-0 (24 VAC, DIN rail mountable)
- LP-FXPM263-0 (90-263 VAC, DIN rail mountable)
- LP-FXPMUS-0 (90-240 VAC, with U.S. wall

adapter)
- LP-FXPMEU-0 (90-240 VAC, with European wall

adapter)
- LP-FXPMUK-0 (90-240 VAC, with U.K. wall

adapter)
• Communication cards (if ordered):

- LP-FXLONFTT-1
- LP-FXRS232-0
- LP-FXRS485-0
- LP-FXWTC-0

• Expansion Input/Output (NDIO) Modules (if ordered)
LP-FXNDIO16-0-

- LP-FXNDIO34-0
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Materials and Special Tools Needed
You may require the following materials and tools for
installation:

• a suitable power module, such as one of the following
types:
- 24 VAC or 24 VDC, in-line, DIN mount capable,

with grounding wire
- 120-240 VAC, in-line, DIN mount capable, with

grounding wire
- FX-PM: external wall-mount power adapter (input

90-254 VAC, 50-60 Hz, output: 15 VDC, 1A),
where FX-PM varies by AC wall plug, for
installation locale (for example, FX-PMUS for U.S.
or Japan installation, FX-PMEU for European
installations, type C plug, or FX-PMUK for United
Kingdom installations, type B plug)

• if using a 24 VAC power module, either one of the
following:
- UL listed, Class 2, 24 VAC transformer, rated at

minimum of 7.5 VA to 20 VA (approximate range
of controller alone, to fully expanded unit with four
additional NDIO16 modules and other option
boards). A dedicated transformer is required.

- 24 VDC power supply, capable of supplying at
least 1 A (24 W)

• DIN Rail: type NS35/7.5 (35 x 7.5 mm) and DIN rail
end clips. Length of DIN rail depends on the number
of optional DIN rail mounted options.

• suitable tools and fasteners for mounting unit and
accessories.

• #2 Phillips screwdriver: used to install and remove
any option card.

• small flat-blade screwdriver: used for making wiring
connections to removable screw terminal plugs and
mounting and removing modules from the DIN Rail.

Safety Precautions
The following information relates to the installation and
startup of the FX30E/FX60E.

Risk of Electric Shock. Disconnect the power supply
before making electrical connections. Contact with
components carrying hazardous voltage can cause
electric shock and may result in severe personal injury
or death.

AVERTISSEMENT: Risque de décharge électrique.
Débrancher l'alimentation avant de réaliser tout
branchement électrique. Tout contact avec des
composants conducteurs de tensions dangereuses
risque d'entraîner une décharge électrique et de
provoquer des blessures graves, voire mortelles.

Important: Use copper conductors only. Make all wiring
connections in accordance with local,
national, and regional regulations. Do not
exceed the FX30E/FX60E electrical ratings.

Important: Do not install or use the FX30E/FX60E in
or near environments where corrosive
substances or vapor could be present.
Exposure of the FX30E/FX60E to corrosive
environments may damage the device's
internal components, and will void the
warranty.

Important: Use this FX30E/FX60E only as an operating
control. Where failure or malfunction of the
FX30E/FX60E could lead to personal injury
or property damage to the controlled
equipment or other property, additional
precautions must be designed in the control
system. Incorporate and maintain other
devices, such as supervisory or alarm
systems or safety or limit controls, intended
to warn of or protect against failure or
malfunction of the FX30E/FX60E.
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Static Discharge Precautions
Static charges produce voltages high enough to damage
electronic components. The microprocessors and
associated circuitry within an FX30E/FX60E are sensitive
to static discharge.

Important: Work in a static-free area. Discharge any
static electricity youmay have accumulated.
Discharge static electricity by touching a
known, securely grounded object. Do not
handle the Printed Circuit Board (PCB)
without proper protection against static
discharge. Use a wrist strap when handling
PCBs. Secure the wrist strap clamp to earth
ground.

Accessories
The FX30E/FX60E has a 20-pin, right-angle, Euro-DIN
connector that accepts accessory modules. The
connector provides power and signal lines to any
connected modules. The connector is located on the end
of the FX30E/FX60E opposite the option cards.

Important: Turn off power to the FX30E/FX60E before
inserting or unplugging accessory modules.
Wait for the LED activity to stop (all LEDs
off).

Risk of Property Damage. Do not apply power to the
system before checking all wiring connections. Short
circuited or improperly connected wires may result in
permanent damage to the equipment.

MISE EN GARDE: Risque dégâts matériels. Ne pas
mettre le système sous tension avant d'avoir vérifié tous
les raccords de câblage. Des fils formant un court-circuit
ou connectés de façon incorrecte risquent
d'endommager irrémédiablement l'équipement.

Each accessory module has a DIN-mount base, and
typically provides two 20-pin connectors that allow you
to chain multiple accessories (see DIN Rail Mounting
Instructions). Table 1 lists the currently available modules.

Accessory Module Details
Table 1: Accessory Module Details

NotesDescriptionModel
Install only one power module per
FX30E/FX60E, regardless of type

Power module for FX30E/FX60E

24 VAC/DC, DIN rail mountable

LP-FXPM24-0

Install only one power module per
FX30E/FX60E, regardless of type.

Power module for FX30E/FX60E

90-263 VAC, DIN rail mountable

LP-FXPM263-0

Provides the following I/O points:
• 8 universal inputs (UIs)
• 4 digital outputs (DOs), single-pole

single-throw (SPST) relay type
• 4 analog outputs (AOs) (0-10 VDC)

Up to four (maximum) NDIO16 accessory
modules are supported

16 channel input/output module for
FX30E/FX60E, DIN rail mountable

LP-FXNDIO16-0

Provides the following I/O points:

• 16 universal inputs (UIs)
• 10 digital outputs (DOs), SPST relay

type
• 8 analog outputs (AOs) (0-10 VDC)

One NDIO34 plus up to 2 additional
NDIO16 modules are supported. Do not
power the NDIO34 if using a separate wall
plug power module.

34 channel input/output module for
FX30E/FX60E, DIN rail mountable. In
addition, the NDIO34 provides power to
the attached FX30E/FX60E, using an
externally supplied 24 VAC transformer or
24 VDC power supply.

LP-FXNDIO34-0
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Mounting
Mount the FX30E/FX60E in a location that allows
clearance for wiring, servicing, and module removal.

Follow these recommendations and precautions when
mounting and installing the unit.

• Use this controller for indoor use only. Do not expose
the unit to ambient conditions outside the range of 0
to 50ºC (32 to 122ºF) and relative humidity outside
the range of noncondensing 5 to 95% (Pollution
Degree 3).

• Supply voltage requirements are as follows:
Allowable voltage fluctuation to -15%, +10%,
Temporary overvoltages +/- 15%

-

- Transient overvoltages: Overvoltage Category 2
• For a controller mounted inside an enclosure, ensure

that the enclosure is designed to keep the unit within
its required operating range (considering a 20-watt
dissipation by the controller). This enclosure is
especially important if the controller is mounted inside
an enclosure with other heat producing equipment.

• Do not mount the unit:
in an area where excessive moisture, corrosive
fumes, or explosive vapors are present

-

- where vibration or shock is likely to occur
- in a location subject to electrical noise. This

includes the proximity of large electrical
contactors, electrical machinery, welding
equipment, variable frequency drives, and spark
igniters.

Physical Mounting
The following information applies to the physical mounting
of the FX30E/FX60E.

• You do not need to remove the cover before
mounting.

• Mount the FX30E/FX60E in any orientation.

• Mount the unit on a 35-mm wide DIN rail
(recommended). The FX30E/FX60E unit base and
its accessories have molded DIN rail slots and locking
clips. Mounting these components on a DIN rail
ensures accurate alignment of connectors between
all modules.

• If DIN rail mounting is impractical, use screws in
mounting tabs on the FX30E/FX60E and in any
end-connected accessory (power module, NDIO
module). See Figure 2 for tab dimensions.

DIN Rail Mounting Instructions
1. Securely install the DIN rail using at least two screws

near both ends of the rail.
2. Position the FX30E/FX60E on the rail, then tilt it to

hook the DIN rail tabs over one edge of the DIN rail
(Figure 3).

3. Use a screwdriver to pry down the plastic locking clip,
and push the FX30E/FX60E down and in, which
forces the locking clip to snap over the edge of the
DIN rail.

4. Mount the accessory modules (NDIO modules and
power module) onto the DIN rail in the same manner
(Figure 5). See Table 1 for quantities allowed.

5. Slide the accessory along the DIN rail to connect its
20-position plug into the FX30E/FX60E.

6. Repeat these instructions for all accessories, until all
are mounted on the DIN rail and firmly connected to
each other. For an example, see Figure 4.

To keep the final assembly together, secure the
assembly at both ends with DIN rail end-clips. This
action also prevents the assembly from sliding on the
DIN rail. See Figure 4.
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Figure 2: Tab Mounting Dimension, in. (mm)
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Figure 3: DIN Rail Mounting

Figure 4: Using End Clips to Secure Modules
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Figure 5: Mounting Accessories

Removing and Replacing the
Cover
The FX30E/FX60E cover is removable. Youmust remove
the FX30E/FX60E cover to connect the optional battery
on a new unit, to replace the optional battery on an
existing unit, or to install any optional communication
cards. The cover snaps onto the base with four plastic
tabs (two on each end). To remove the cover, press in
the four tabs on both ends of the unit and lift off the cover.

Note: If accessory modules are plugged into the
FX30E/FX60E, you may need to slide them away
from the unit to get to the cover tabs.

To replace the cover, position it so the cutout area for the
communication ports is correct, then push inward to snap
in place.

Figure 6: Removing and Replacing the Cover
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Board Layout
See Figure 7 for the location of LEDs, option slots, and
other features of the FX30E/FX60E. See Figure 10 for a
side view of communication ports and other features. The
FX30E/FX60E ships with onboard static RAM (SRAM)
that can provide station backup during power loss, and
also has two open option card slots for a variety of
available option cards.

Note: An optional NiMH battery pack is included, but
not connected. For connection instructions, see
Backup Configurations.

Figure 7: FX30E/FX60E Board Layout Details
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Expansion Options
The FX30E/FX60E provides for field-installable expansion
with two options:
• Option Cards: these are installed on connectors inside

the FX30E/FX60E base unit. See Option Cards.
• Accessory Modules: these are chained onto the

FX30E/FX60E’s 20-pin connector. See Accessories.

Option Cards
The FX30E/FX60E has two options slots for custom
option cards designed for use with the FX30E/FX60E.
Each slot has a 30-pin connector on the FX30E/FX60E
base unit.

Risk of Property Damage. Do not apply power to the
system before checking all wiring connections. Short
circuited or improperly connected wires may result in
permanent damage to the equipment.

MISE EN GARDE: Risque dégâts matériels. Ne pas
mettre le système sous tension avant d'avoir vérifié tous
les raccords de câblage. Des fils formant un court-circuit
ou connectés de façon incorrecte risquent
d'endommager irrémédiablement l'équipement.

Important: Power to the controller must be off when
installing or removing option cards or
damage will occur.

Important: Be careful to plug an option card into the
connector properly with its pins properly
aligned.

Option cards typically provide additional communication
capabilities, such as those listed in Table 2. For a list of
supported COM port and slot assignments for the option
cards, see Table 3.

Table 2: Option Card Details
Number of Option Cards Allowed
per Controller

DescriptionModel

One or twoLONWORKS FTT-10A adapter with a
2-position removable screw terminal plug

LP-FXLONFTT-1

One or twoDual, optically isolated, RS-485 adapter
with two 3-position removable screw
terminal connector plugs

LP-FXRS485-0

One or twoSingle port RS-232 adapter, with a DB-9M
connector

LP-FXRS232-0

OneWireless TEC Card (WTC) with direct
mount antenna

LP-FXWTC-0

OneSedona Framework™ option cardLP-FXSED-0

OneGPRS Modem cardLP-FXGPRS-0

OneGPRS Modem option card with Wyless™
SIM card

LP-FXGPRSW-0

Table 3: COM Port and Option Slot Assignments for FX30E/FX60E Option Cards
Onboard RS485Onboard RS232Option Slot 2Option Slot 1
COM2COM1NoneNone

COM2COM1NoneRS-232 = COM3

COM2COM1RS-232 = COM4RS-232 = COM3

COM2COM1RS-485 = COM4, COM5RS-232 = COM3

COM2COM1LON = LON1RS-232 = COM3

COM2COM1Sedona = COM4RS-232 = COM3

COM2COM1GPRS = COM4,COM5RS-232 = COM3
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Table 3: COM Port and Option Slot Assignments for FX30E/FX60E Option Cards
Onboard RS485Onboard RS232Option Slot 2Option Slot 1
COM2COM1NoneRS-485 = COM3, COM4

COM2COM1RS-232 = COM5RS-485 = COM3, COM4

COM2COM1RS-485 = COM5, COM6RS-485 = COM3, COM4

COM2COM1LON = LON1RS-485 = COM3, COM4

COM2COM1Sedona = COM5RS-485 = COM3, COM4

COM2COM1GPRS = COM5, COM6RS-485 = COM3, COM4

COM2COM1NoneLON = LON1

COM2COM1RS-232 = COM3LON = LON1

COM2COM1RS-485 = COM3, COM4LON = LON1

COM2COM1LON = LON2LON = LON1

COM2COM1Sedona = COM3LON = LON1

COM2COM1GPRS = COM3, COM4LON = LON1

COM2DisabledNoneWireless TEC = COM1

COM2DisabledRS-232 = COM3Wireless TEC = COM1

COM2DisabledRS-485 = COM3, COM4Wireless TEC = COM1

COM2DisabledLON = LON1Wireless TEC = COM1

COM2DisabledSedona = COM3Wireless TEC = COM1

COM2DisabledGPRS = COM3, COM4Wireless TEC = COM1

COM2COM1NoneSedona = COM3

COM2COM1RS-232 = COM4Sedona = COM3

COM2COM1RS-485 = COM4, COM5Sedona = COM3

COM2COM1LON = LON1Sedona = COM3

COM2COM1GPRS = COM4,COM5Sedona = COM3

COM2COM1NoneGPRS = COM3, COM4

COM2COM1RS-232 = COM5GPRS = COM3, COM4

COM2COM1RS-485 = COM5, COM6GPRS = COM3, COM4

COM2COM1LON = LON1GPRS = COM3, COM4

COM2COM1SEDONA = COM5GPRS = COM3, COM4
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Mounting Option Cards
For complete details, refer to the specific mounting and
wiring guide that shipped with the option card. Follow
these basic steps:

1. If a station is running, stop the station using the
platform Application Director View.

2. Remove power from the controller.
3. Remove the optional battery and bracket assembly

by taking out the four screws holding it in place. Set
the screws aside for later. Unplug the battery from
the connector on the FX30E/FX60E (if the battery is
being used in addition to the integral SRAM for
backup).

4. Remove the blanking end plate for the slot into which
you are installing the option card. Retain the blanking
plate in case you need to remove the option card at
a later time.

5. Carefully insert the pins of the option card into the
socket of the appropriate option card slot. The
mounting holes on the option card should line up
with the standoffs on the base unit. If they do not,
the connector is not properly aligned. Press until the
option card is completely seated.

6. Place the custom end plate that came with the option
card over the connector of the option card.

7. Insert the battery connector plug into the battery
connector on the FX30E/FX60E.

8. Set the battery and bracket assembly back over the
option card slots, with the mounting holes aligned
with the standoffs.

9. Place the four screws through the battery bracket,
end plates, and into the standoffs on the
FX30E/FX60E base unit. Hand-tighten these screws.

10. Replace the cover.
11. Restore power to the FX30E/FX60E.

Wiring
See Figure 8 to locate connectors and other components
on the FX30E/FX60E. Make connections to the
FX30E/FX60E in the following order.

1. Install any option cards (LON, RS-232, RS-485,
modem,WTC) in Option Slots 1 and 2. See Mounting
Option Cards for the general procedure. For complete
details, refer to the specific mounting and wiring guide
that shipped with the option card.

2. Connect the supplied earth grounding wires (with
spade connector) from the earth ground lug on the
FX30E/FX60E and any accessory modules (if used)
to a nearby earth grounding point. See Grounding for
details.

3. Prepare power wiring (leave the unit powered off).
See Power Wiring for details.

4. Connect communications cables. See
Communications Wiring for ports available on the
FX30E/FX60E base unit. For ports on any installed
option card (LON, RS-232, RS-485, modem, and
WTC), refer to the specific mounting and wiring guide
for additional details.

5. If NDIOmodules are installed, connect the I/O wiring.
Refer to the appropriate mounting and wiring guide
for complete details.

6. Apply power to the unit. See Powerup and Initial
Checkout.

Grounding
An earth ground spade lug (0.187 in. [4.75 mm]) is
provided on the base of the FX30E/FX60E for connection
to earth ground. For maximum protection from
electrostatic discharge or other forms of electromagnetic
interference, connect the supplied earth grounding wire
to this lug and a nearby earth ground (Figure 9). Keep
this wire as short as possible.

Power is provided for the FX30E/FX60E plug-in accessory
modules through the 30-pin accessory connectors;
however, connect the earth ground spade lug of each
accessory module to ground in the same manner.

Power Wiring
The FX30E/FX60E must be powered by an approved 15
VDC power source. This source can come from one of
the following:

• a DIN rail mount 24 VAC/DC powered module
(LP-FXPM24-0)

• a DIN rail mount line voltage (120-240 VAC) module
(LP-FXPM263-0)

• an external Class 2 wall mount AC adapter
(LP-FXPMUS/EU/UK-0)

The FX30E/FX60E does not include an on/off switch. To
apply power, you can do one of the following:

• plug in the power connector to the FX30E/FX60E, if
the wall mount power module is used

• plug in its 2-position power connector, if the 24 VAC
DIN rail power supply is used

• energize the AC circuit (120-240 VAC) wired to that
module, if the line voltage DIN rail power supply is
used
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Risk of Property Damage. Do not apply power to the
system before checking all wiring connections. Short
circuited or improperly connected wires may result in
permanent damage to the equipment.

MISE EN GARDE: Risque dégâts matériels. Ne pas
mettre le système sous tension avant d'avoir vérifié tous
les raccords de câblage. Des fils formant un court-circuit
ou connectés de façon incorrecte risquent
d'endommager irrémédiablement l'équipement.

If desired, you can use the wall mount power adapter in
your office to initially commission the FX30E/FX60E, and
then install the DIN rail mount power supply at the project
site.

Important: Do not connect both the LP-FXPMUS and
LP-FXPM24 supplies at the same time, or
equipment damage may result.

Wall Mount Power Module
Threemodels of wall power modules are available: United
States (U.S.), European Union (EU), and United Kingdom
(U.K.). All are self-contained, isolated switching power
supplies designed to plug into a standard building power
receptacle for appropriate voltage. To supply power to
the FX30E/FX60E, you simply plug the barrel connector
plug from the power module into the barrel power
connector on the FX30E/FX60E base unit.

Important: Do not plug the barrel connector plug from
the power module into the FX30E/FX60E
until all other mounting and wiring is
completed.

Wiring LP-FXPM24-0 Power Module
The LP-FXPM24-0 module lets you power the
FX30E/FX60E (and, if installed, the NDIO16 modules)
from a dedicated, Class 2, 24 VAC transformer, or from
a 24 VDC power supply. If installing NDIO16 modules,
install the power module as the last (end) module in the
chain. See Figure 5.

Important: If powering from a 24 VAC transformer, do
not power any other equipment with it.
Otherwise, conducted noise problems may
result. Also, do not ground either side of the
transformer’s secondary.

Located at the bottom of the power module are a
2-position power connector and an earth ground spade
lug. Connect the supplied earth ground wire to a nearby
earth ground point. Unplug the power connector plug
from the module and make connections to it.

Risk of Property Damage. Do not apply power to the
system before checking all wiring connections. Short
circuited or improperly connected wires may result in
permanent damage to the equipment.

MISE EN GARDE: Risque dégâts matériels. Ne pas
mettre le système sous tension avant d'avoir vérifié tous
les raccords de câblage. Des fils formant un court-circuit
ou connectés de façon incorrecte risquent
d'endommager irrémédiablement l'équipement.

Power consumption depends on installed accessories
and option cards, and may vary from:

• FX30E/FX60E with power module alone:
approximately 7.5 VA (AC) or 7.5 W (DC)

• FX30E/FX60E with power module and 4 NDIO
modules, plus option cards: up to 20 VA (AC) or 20
W (DC)
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Figure 8: LP-FXPM Power Module Wiring Connections
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LP-FXPM263-0 Line Voltage
Power Module
You can power the FX30E/FX60E using the
LP-FXPM263-0 module (and, if installed, the NDIO16
modules) from AC line power, with a universal input range
from 120-243 VAC. If installing NDIO16 modules, install
the power module as the last (end) module in the chain
(Figure 5).

Risk of Electric Shock.Disconnect power supply before
making electrical connections. Contact with components
carrying hazardous voltage can cause electric shock
and may result in personal injury or death.

AVERTISSEMENT: Risque de décharge électrique.
Débrancher l'alimentation avant de réaliser tout
branchement électrique. Tout contact avec des
composants conducteurs de tensions dangereuses
risque d'entraîner une décharge électrique et de
provoquer des blessures graves, voire mortelles.

Note: The 6-pin connector of the LP-FXPM263-0 is not
used with a FX30E/FX60E.

Figure 9: LP-FXPM263-0 Line Voltage Power Module Wiring Connections
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Wiring the DIN Rail Mount Line
Voltage Power Module
To wire the DIN rail mount line voltage power module,
see Figure 9 and follow these instructions:

1. Remove power from the AC circuit being wired to the
power module.

2. Remove the power module cover by pressing in the
four tabs on both ends of the unit, and lifting the cover
off. If the power module is plugged into the
FX30E/FX60E or an NDIO16, you may need to slide
it away to access the cover tabs.

3. Connect the supplied earth grounding wire to a nearby
grounding point (Figure 9).

4. Make AC circuit connections line (mains) and neutral
to the terminals labeled INPUT PWR.

5. Replace the cover on the power module.
6. Make sure that all modules in the assembly are firmly

connected together and secured.

Risk of Property Damage. Do not apply power to
the system before checking all wiring connections.
Short circuited or improperly connected wires may
result in permanent damage to the equipment.

MISE EN GARDE: Risque dégâts matériels. Ne
pas mettre le système sous tension avant d'avoir
vérifié tous les raccords de câblage. Des fils formant
un court-circuit ou connectés de façon incorrecte
risquent d'endommager irrémédiablement
l'équipement.

Communication Wiring
Connect communications wiring to the ports on the bottom
of the FX30E/FX60E.
Note: Prior to connecting cables, provide strain relief for

them to prevent damage to the controller.
Figure 10: FX30E/FX60E Bottom Side (Cover Removed)

Ethernet Port
Two female 10/100-Mbit Ethernet connections are
provided on the FX30E/FX60E. These connections are
capable of running at either 10 Mbps or 100 Mbps; the
controller automatically adjusts to either speed. This
means the FX30E/FX60E can exist on the same network
with a mixture of 10BaseT and 100BaseTX hardware
connected to a smart 10/100 hub capable of adjusting to
the devices it supports.

Two RJ-45 connectors labeled LAN1 and LAN2 are
provided for the Ethernet connections (Figure 9). Use a
standard Ethernet patch cable for connecting to a hub or
Ethernet switch. An activity LED for each Ethernet port
is visible, labeled LAN1 and LAN2 on the cover.

The factory-default IP address for LAN1 is 192.168.1.149.
By default, LAN2 is disabled.

Note: Typically, you only use LAN1 (primary port). If you
have a specific application for isolating a driver's
network traffic to a separate local area network
(LAN), you can use LAN2. Do not use LAN2 as
the primary port.
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Serial Ports
The FX30E/FX60E has two serial ports (Figure 10). Each
port has a Universal Asynchronous Receive Transmit
(UART) capable of operating up to 115,200 baud. The
left port is an RS-232 port that requires a DB-9 male plug
connector. The right port is a non-isolated RS-485 port
that uses two wires with a shield connection and a
screw-terminal connector plug.

Note: A green receive LED and yellow transmit LED are
provided for each serial port. These LEDs are
located on the bottom board opposite of the serial
connectors (Figure 7). The LEDs are labeled on
the board (COM1, COM2) and are not visible with
the cover on.

RS-232 Port
An RS-232 serial port uses a DB-9 male connector and
always operates as COM1. You can use a standard DB-9
serial cable with this port. The FX30E/FX60E is a serial
Data Terminal Equipment (DTE) device, so connecting
another DTE device (computer) requires a null modem
cable. To connect the FX30E/FX60E to a Data
Communication Equipment (DCE) device (modem), use
a straight-through cable. Table 4 provides the standard
serial DB-9 pinouts.

Table 4: Serial Port Pinouts
Base RS-485 Port
(COM2) Pinouts

DB-9 Plug PinSignalPinout References

1Data carrier detectDCDDB-9 Plug (Male)

2Receive dataRXD

3Transmit dataTXD

4Data terminal readyDTR

5GroundGND

6Data set readyDSR

7Request to sendRTS

8Clear to sendCTS

9Not used on the FX30E/FX60E

RS-485 Port
An RS-485 non-isolated port uses a 3-position, screw
terminal connector and always operates as COM2. Use
shielded 18-22 AWG wire for this connector (refer to the
Telecommunications Industry Association/Electronic
Industries Alliance [TIA/EIA-485 standard]). As shown in
Table 4, the screw terminals (from left to right) are shield,
plus (+), and minus (–).

RS-485 Biasing
The FX30E/FX60E's RS-485 port has a pair of 2-pin
jumpers that can be shorted with jumper blocks to provide
biasing. When shipped from the factory, these pins are
not shorted and therefore, the RS-485 port is unbiased.

Biasing can improve RS-485 communications by
eliminating indeterminate idle states. When you install
two, 2-pin shorting blocks on the controller's RS-485 bias
jumper pins, the shorting blocks add two onboard 3.3K
ohm resistors into the controller's RS-485 circuit, as
follows:

• from RS-485 plus (+) to 5 V
• from RS-485 minus (-) to ground

Note: Only one device on an RS-485 trunk should be
biased. Otherwise, undue loading of the circuit
may result with fewer devices supported.

Note: RS-485 bias resistors are different than
termination resistors, externally installed at the
two physical ends of a daisy-chained RS-485
trunk, across the plus (+) and minus (-) terminals.
Termination resistors are typically 100 or 120 ohm
value resistors.

Note: If termination resistors are used, RS-485 biasing
is typically required.
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Adding RS-485 Bias
To add biasing, power off the FX30E/FX60E and remove
the necessary assemblies (such as metal shield) to
access the base board jumper pins located behind the
RS-485 port. Then reposition the two shorting blocks on
these jumper pins and reassemble the unit by remounting
the processor module, hex standoffs, metal shield, and
shield screws.

Risk of Electric Shock. Disconnect the power supply
before making electrical connections. Contact with
components carrying hazardous voltage can cause
electric shock and may result in personal injury or death.

AVERTISSEMENT: Risque de décharge électrique.
Débrancher l'alimentation avant de réaliser tout
branchement électrique. Tout contact avec des
composants conducteurs de tensions dangereuses
risque d'entraîner une décharge électrique et de
provoquer des blessures graves, voire mortelles.

If the controller is already installed or mounted, we
recommend that you remove the controller first. Then
work on a flat, stable, well lit work surface.

Figure 11: Basic Stages of Controller Disassembly
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Disassembling the Controller
1. Remove power from the controller.
2. Remove the plastic cover.
3. With a Phillips head screwdriver, remove the four

screws that secure the metal shield, and set the
screws aside.

4. Remove the metal shield. Carefully pry the shield up
from the top (hole vented side) first and then push
out the other side to slip the port holes past the port
edges. Then lift the shield up and away. Set shield
aside.

Note: Be mindful of the side clips on the controller's
two Ethernet ports.

5. Use a 1/4 in. (7 mm) nut driver to unscrew the four
metal standoffs, and set them aside.

6. Carefully pry up the FX30E/FX60E module board,
noting that the two-row, 50-pin connector is on the
option card side. Keep the board level as you work it
loose from this connector.

Set the processor module board aside. Note the
jumper block on the base board behind the RS-485
port.

Figure 12: Installing Shorting Blocks across Both Sides of Jumper Block

Installing Shorting Blocks to Add
RS-485 Biasing
1. Locate the four jumper pins behind the RS-485 port,

with 2-pin shorting blocks installed on one pin each.
2. To add biasing, remove and replace both shorting

blocks back onto the jumper pins.

Reassembling the Controller
1. Carefully replace the processor module board onto

the 50-pin connector, with its corner mounting holes
aligned on the four lower standoffs. Press down on
the connector to fully seat the board.

2. Refasten the four metal hex standoffs by hand
tightening with a 1/4 in. (7 mm) nut driver.

3. Replace the shield back onto the unit. Carefully ease
the shield over the port side first and then spring it
down over the other side. Make sure that the shield’s
corner holes align with the metal standoffs.

4. With a Phillips head screwdriver, refasten the four
screws that secure the shield to the standoffs.

5. Replace the plastic cover onto the unit.

Setup and Adjustments

Default Communication and Login
Properties
The new FX30E/FX60E is pre-configured with default
properties as defined in Table 5.

Table 5: FX30E/FX60E Default Properties
Default PropertyName
192.168.1.149Internet Protocol (IP)

Address

255.255.255.0Subnet Mask

192.168.1.1Default Gateway

jciRemote User Name

explorerRemote Password
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Powerup and Initial Checkout
Ensure that power wiring to the transformer is complete
before you proceed.

After you have completed all mounting and wiring steps:

1. Do one of the following:

• Insert the power plug into either the 24 VAC/DC
power module, or if using a wall adapter, the
FX30E/FX60E.

• Energize the 120–240 VAC circuit wired to the
module, if using the line voltage power supply
module.

2. Apply power.

Important: Do not connect both the wall power
module and the DIN rail power modules
at the same time, or equipment damage
will result, or a power outage may go
unrecognized.

Backup Configurations
An FX30E/FX60E allows two separate and configurable
methods to preserve unsaved station data when power
quality events occur, including loss of primary power or
low-voltage dips (brownout):

• Using the integral Static RAM (SRAM) on the
FX30E/FX60E.
This default method allows the unit to operate
battery-less (without installing the optional NiMH
battery pack). Note in this configuration, a reboot is
likely to occur when a power outage or voltage dip is
sustained for more than one AC line cycle (1/50th or
1/60th of a second) or a number of line cycles,
depending on the load and power supply. Critical
station data already is saved prior to any power quality
event, but the NiMH battery option is available to
prevent nuisance controller reboots during extended
or frequent power outages.

• Using an optional on-board NiMH battery pack.
Connecting the optional battery allows the controller
to continue operation (without rebooting) over short
power outages or brownouts lasting several seconds
(or if also using SRAM, up to 10 minutes). For longer
duration outages, the battery allows the controller to
perform a controlled shutdown, safely backing up the
station before shutting down.

The FX30E/FX60E can use both the NiMH backup
battery and available SRAM for backup protection.
Configuring for both backup battery and SRAM
support provides the most comprehensive backup
protection. This configuration allows the

FX30E/FX60E to handle brief power outages, while
also protecting against a weak or aged battery.

SRAM
The FX30E/FX60E includes an on-board SRAM and
associated circuitry, allowing battery-less operation. A
separate SRAM option card is not needed (or supported)
in an FX30E/FX60E controller.

The default station backup configuration is to use SRAM,
via the platform DataRecoveryService, which is
automatically created in the FX30E/FX60E’s running
station. However, in some cases, a station may be a poor
candidate for SRAM support, requiring too many
resources by the associated platform service (for
example, a station with many rapidly changing values all
captured as histories, on change of value). In this case,
you may need to disable SRAM support, and install and
use only the optionally included NiMH battery pack.

NiMH Battery Pack
Use the custom 10-cell NiMH (nickel metal hydrite) battery
assembly (included with the product) as an alternative
to, or with, the SRAM backup method.

This battery allows the controller to continue station
operation through short power bumps, ranging from a
few seconds to a minute or more in duration (up to 10
minutes, if also using SRAM). If the controller experiences
a longer outage, the NiMH battery provides enough run
time for the unit to backup data and then shutdown.
Shutdown occurs automatically, after data is backed up
to on-board flash memory.

The FX30E/FX60E charges the battery during normal
operation, until the controller is fully charged. Typically,
the charge operation completes within 18 hours. Following
a power outage, the battery is charged again, as
necessary. The power and battery circuitry is monitored
by a station running on the FX30E/FX60E (via its
PowerMonitorService). Station alarms are generated
when primary power is lost, or if the battery is uncharged
or unable to hold a sufficient charge.

Connecting the Backup Battery
With the cover removed from the FX30E/FX60E, locate
the red and black wires with a plug on the backup battery.
Insert the plug into the battery connector on the bottom
board.
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Figure 13: Backup Battery Connector Location

The connector is keyed so you cannot insert it incorrectly.
The red (positive) connection should be the furthest from
the two 30-pin option board connectors.

Note: A NiMH battery characteristic is to lose charge if
not left in charge mode (trickle charge). Leaving
the battery unconnected, or in the unit powered
off causes the battery to fully discharge in a matter
of weeks. Note that a new NiMH battery may be
partially discharged. Therefore, allow at least 18
hours for a new battery to charge if it has not been
in a powered unit.

The NiMH battery assembly should be replaced
approximately every three years or more often if the unit
is in a high temperature environment.

EnablingBattery Only Backup Service
If a station is not compatible with SRAM support and you
want to use the optional backup battery instead of the
onboard SRAM, connect the optional NiMH battery pack
to the FX30E or FX60E.

In the station’s DataRecovery-Service, set the Service
Enabled property to false. In the station’s
PlatformServices, make sure the Battery Present
property is true.

Status LEDs

Checking the Status LEDs
When power is applied, the green LED labeled Status is
lit. This LED status indicates that the system is normal
and power is applied. Once the FX30E/FX60E boots, the
yellow BEAT (heartbeat) LED begins to blink, with a
typical rate of about one blink per second. Blinking should
begin within 30 seconds after power is applied.

If, after applying power, the STATUS LED goes out, or
the BEAT LED comes on steady and stays lit for longer
than 2 minutes, contact your technical support
representative for assistance. See also Using Status
LEDs.

Using Status LEDs
The FX30E/FX60E includes several LEDs that can help
determine the status of the unit. These LEDs include:

• Ethernet Ports
• Heartbeat
• Status
• Serial Ports

See Figure 7 for the location of the status LEDs.

Ethernet Ports LEDs
Each Ethernet port has one green LED, visible on the top
cover. A LAN# LED indicates activity on that port as
follows:

• Off: No Ethernet link is established.
• On: Ethernet link is established, but no activity is on

the LAN.
• Blinking:Ethernet link is established with data activity

on the LAN.

Heartbeat LED
The yellow BEAT LED is located to the right of the
Ethernet status LEDs. Under normal operation, this LED
should blink about once per second. If the BEAT LED
stays on constantly, does not light, or blinks very fast
(more than once per second), contact your technical
support representative for assistance.

Important: During boot-up, the heartbeat LED blinks in
a 90% on, 10% off pattern. Do not remove
power during this time, or data loss may
result (NDIO module’s firmware upgrade
may be in progress).
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Status LED
The green Status LED is located to the right of the
heartbeat (BEAT) LED. This LED provides a central
processing unit (CPU)machine status check, and remains
lit whenever the FX30E/FX60E is powered. If the Status
LED does not light while power is applied, contact your
technical support representative for assistance.

Serial Port LEDs
LEDs for the two serial ports are located on the
FX30E/FX60E’s bottom board on the opposite side of the
RS-232 and RS-485 ports (Figure 7). Labels COM1 and
COM2 correspond to the software configuration of the
COM ports. LEDs show, transmit, and receive activity for
the serial ports and optional modem.

Note: You must remove the cover to see the serial port
LEDs. See Removing and Replacing the Cover.

• The yellow Transmit LED indicates that the
FX30E/FX60E is sending data out the serial port over
a communications line to a connected device.

• The green Receive LED indicates that the
FX30E/FX60E is receiving data from a connected
device.

These LEDs are driven by pulse detectors that provide
a fixed on-time sequence when data is detected on the
port. If the receive LED is on constantly, a problem with
the communications channel may be present, such as a
shorted wire or reversed wiring.

NiagaraAX Software Installation
As shipped from the factory, the FX30E/FX60E is
preconfigured with a Niagara build, a license, and
Johnson Controls® specific Java® Archive (JAR) files.
With these components in place, you only need to change
login credentials and IP settings (per network
requirements) when setting up the FX30E/FX60E. This
section provides step-by-step instructions for these tasks.

To set up an FX30E/FX60E (and to upgrade to a newer
Niagara build at a later date), use the Commissioning
Wizard in the Platform/Platform Administration view.

Note: If you plan to update the JAR files with patches
at a later date, use the Driver Upgrade Tool
Commissioning Wizard or Software Manager in
the Platform view. If you are changing login
credentials, use the Change Remote Login
Credentials menu item.

Preparing for Setup

Providing Power and Connectivity
Perform the initial startup of an FX30E/FX60E in your
office before physically mounting it in place at a job site.

After you complete the commissioning process, mount
and wire the FX30E/FX60E at the job site, making
permanent mounting and wiring connections.

For this initial Ethernet connection, you can use one of
the following:
• a crossover cable connected directly between your

computer and the FX30E/FX60E
• a standard Local Area Network (LAN) connection in

which your computer and the FX30E/FX60E are
physically connected to the same Ethernet hub or
switch

IP Address
When shipped, a new FX30E/FX60E Series controller is
pre-configured with an IP address of 192.168.1.149 and
a default subnet mask of 255.255.255.0.

1. Use the Microsoft®Windows®Network Connections
utility on your workstation to configure your
Transmission Control Protocol (TCP)/IP settings with
an IP address of 192.168.1.100 and subnet mask of
255.255.255.0.

2. Make an Ethernet connection to the FX30E/FX60E.
3. Run the FX Workbench application.
4. On the File Menu, click Open Remote Station.

a. Enter the Remote Site Address (192.168.1.149),
Remote Platform User Name (jci), and Remote
Password (explorer). Click OK.

b. When the Authentication dialog box appears, enter
the Station User Name (admin), and password
(FacilityExplorer61). Click OK.

At this point you are prompted to choose a strong
password. A strong password consists of at least eight
characters with at least one numeric and one
alpha-numeric character. Be sure to guard and
remember this password.
Note: Starting in Release 6.1, a blank (empty)

password is not allowed. Further, if the
UserService is configured for strong
passwords (property Require Strong
Passwords)–now the default–the password
must be a minimum of eight characters, with
at least one being a numeral (0-9) or any other
special character, such as !, @, #, $, or %.
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5. The station running on the FX30E/FX60E opens with
the FX Workbench application, which has a
Navigation Tree on the left and a Display Window on
the right. In the Navigation Tree, open the
Administration folder. Double-click the TCP IP
Configuration option.

6. On the TCP/IP Configuration screen, make sure the
Interfaces field is expanded so that the IP Address
and Subnet Mask fields appear. Modify the Gateway,
IP Address and Subnet Mask fields, and click Save.
When prompted to Reboot Now, click Yes. Give the
FX30E/FX60E a couple of minutes to reboot and
restart the station that is installed.

Note: If the following message appears, just click
OK. The changes are saved anyway.

Platform Daemon Credentials
An FX30E/FX60E Series controller is shipped with the
following Platform Daemon (Administrator) credentials:

User Name: jci

Password: explorer

Initially, you use these default credentials to open a
platform connection (log in) to the FX30E/FX60E. Like
the factory-assigned IP address, default credentials are
intended to be temporary. Change these credentials to
be something unique, and guard them closely.

1. Start the FX Workbench application.
2. On the File Menu, click Open Remote Station. When

prompted, enter the Remote Site Address (for
example, 192.168.1.149), Remote Username (jci),
and Remote Password (explorer). Click OK. When
the Authentication dialog box appears, enter the
Username (admin), leave the password field empty,
and click OK.

3. On the Tools menu, click Change Remote Platform
Login Credentials. In the Change Remote Login
Credentials dialog box, fill in the Username,
Password, and Confirm Password fields, then click
OK. The next time you log into the FX30E/FX60E,
use these new credentials.

Restoring a Backed Up Station
If the FX30E/FX60E ever gets into an erroneous condition
where you cannot fix a station, you can restore a
previously backed up station by using the Restore Backed
Up Station menu item under the Tools menu.

1. Run the FX Workbench application.
2. On the File Menu, click Open Remote Station. When

prompted, enter the Remote Site Address (for
example, 192.168.1.149), Remote Platform User
Name (jci), and Remote Password (explorer). Click
OK. When the Authentication dialog box appears,
enter the Station User Name (admin), Password
(optional), and click OK.

3. On the Tools menu, click Restore Backed Up Station.
In the Restore Backed Up Station dialog box, enter
the Remote Site IP Address, Remote Username,
Remote Password, and select the .dist (station
backup) file. Click OK. The FX30E/FX60E reboots
automatically.

Note: You can back up a station by using the Backup
Station menu item from the station node's
popup menu in the Navigation Tree. We
recommend that you back up a station daily
to minimize the chance of information loss.

Cleaning
If dust or metal filings are present inside the unit, clean
with vacuum or compressed air. Otherwise, no cleaning
inside the unit is required. Optionally, if the outer
enclosure becomes dirty, you can wipe it with a damp
cloth and mild detergent.

NiMH Required Battery
Installation Maintenance

Installing or Replacing the Optional
NiMH Battery
The optional NiMH battery pack is sold as an assembly.
The NiMH battery is a custom battery pack with an
attached cable and connector plug, mounted on a bracket.
To install (or replace) the battery, you must remove power
to the controller and remove its cover. Then you mount
the battery assembly on top of the option card area.
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Figure 14: Optional NiMH Battery Pack for FX30E/FX60E

Installing or Replacing the
Battery
Important: Use only NiMH battery packs approved for

use with the FX30E/FX60E.

1. If you are replacing an existing battery in a controller
not currently configured for SRAM usage, back up
the FX30E/FX60E's configuration to your work using
FX Workbench.

2. If a station is running, stop the station using the
platform Application Director view.

3. Remove all power from the FX30E/FX60E. Wait for
LED activity to stop (if a battery is already installed,
this may take a minute or two).

4. Remove the cover. See Removing and Replacing
the Cover. Note the Option Slot area where the NiMH
battery assembly mounts.

5. If a battery assembly is already mounted, unplug the
battery from the connector on the controller board.
See Figure 13.

6. Remove the four screws that secure both option slot
end plates (and if installed, the existing battery
assembly bracket). Set the screws aside. Remove
any existing battery assembly (if applicable).

7. Plug the battery connector plug of the new battery
assembly into the battery connector on the controller.
See Figure 13.

8. Set the new NiMH battery assembly on top of the
option card slots, over the option card end plates.
Ensure the bracket mounting holes are aligned with
the standoffs.

9. Place the four screws through the battery bracket,
option card end plates, and into the standoffs on the
controller's base board. Using a screwdriver,
hand-tighten the screws.

10. Replace the cover.
11. Restore power to the FX30E/FX60E and verify

normal operation.
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Repair Information
Servicing the FX30E/FX60E may call for replacement
parts.

Non-replaceable Parts

Other than the parts listed in the Standard Replacement
Parts section, no serviceable components are on the
base assembly.

Memory

Any addition, modification, or replacement of memory
components requires software configuration changes and
is not field upgradeable. For additional information on
modifying the memory capacity of the FX30E/FX60E,
consult your local sales representative.

Fuse

The FX30E/FX60E contains a non-user replaceable fuse
soldered on the circuit board. This fuse provides
protection from internal shorts or connection to incorrect
power supplies. If the fuse circuitry is suspect, contact
your technical support representative for assistance.

Standard Replacement Parts
Table 6: Standard Replacement Parts

DescriptionPart Number
NiMH Battery Pack: includes
battery bracket (SeeReplacing
the Battery.)

LP-KITFX2BAT-0

New Replacement Unit
To replace a faulty FX30E/FX60E, order a new one. To
ensure proper credit for a FX30E/FX60E still under
warranty, contact the Johnson Controls Product Sales
Operations Team for return authorization.

Replacing an FX30E/FX60E
Important: Before handling circuit boards, discharge

any accumulated static by touching the
metal surface of the FX30E/FX60E.

1. Use FX Workbench to back up the FX30E/FX60E
configuration to your computer.

2. Remove power to the FX30E/FX60E. The unit
powers down automatically.

Note: If NDIO accessory modules are installed, and
any I/O points have voltage, turn the devices
off or disconnect power from them.

3. Note the positions of all communications and other
wiring cables going to the FX30E/FX60E, as well as
all installed accessory modules (if they must be
removed). If necessary, label connectors and

accessory modules to avoid misconnection later
when you are replacing the FX30E/FX60E.

4. Unplug all Ethernet, serial, LON, modem, and I/O
connectors from the FX30E/FX60E.

5. Unplug the earth ground wire.
6. If an NDIO accessory module is installed:

If DIN rail mounting with DIN end clips were
used, you may be able to remove the DIN rail

a.

end clip that secures the FX30E/FX60E end of
the assembly and then slide the FX30E/FX60E
away from the rest of the assembly. Then,
remove the FX30E/FX60E from the DIN rail (see
Figure 3), leaving the mounting and wiring of
the NDIO modules untouched. Go to Step 5.

b. If tab (screw) mounting was used instead of DIN
rail mounting, or if a combination of DIN rail
mounting and tab screws were used, remove
the accessory modules first, then remove the
FX30E/FX60E. Carefully observe all wiring
terminations, then unplug the I/O connector
plugs and earth ground wires from the installed
NDIOmodules. Remove the installed accessory
modules, starting with the end module. You can
secure modules with screws through the
mounting tabs or clipped to a DIN rail, or
fastened by some combination. Remove any
screws fastening the FX30E/FX60E and remove
the FX30E/FX60E.

7. Remove the cover from the old FX30E/FX60E (see
Removing and Replacing the Cover). Note the
position of installed option boards, if any. You must
transfer them to the replacement FX30E/FX60E.

8. Remove the option boards from the old
FX30E/FX60E and install them into the replacement
FX30E/FX60E, if applicable. See Mounting Option
Cards.

9. Mount the replacement FX30E/FX60E as it was
previously, using the same DIN rail location or
screws.

10. Reconnect or remount any removed accessory
modules, being careful to replace them in the same
order, using the same DIN rail location or screws.
Secure all accessory modules as done previously.

11. Reconnect the earth ground wires to the
FX30E/FX60E grounding lug and any installed
accessory modules.

12. Reconnect any Ethernet, serial, modem, and I/O
connectors to the FX30E/FX60E and any installed
accessory modules.

13. If using NDIO modules, and if any of your I/O points
have voltage, turn on the devices or reconnect power
to them.
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14. Restore power to the FX30E/FX60E. To verify
operation, see Checking the Status LEDs.

15. Use FX Workbench to recommission the
FX30E/FX60E and install the saved station database.

Building Efficiency
507 E. Michigan Street, Milwaukee, WI 53202

Johnson Controls® is a registered trademark of Johnson Controls, Inc.
All other marks herein are the marks of their respective owners.© 2015 Johnson Controls, Inc.

www.johnsoncontrols.comPublished in U.S.A.
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